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WELCOME 

 
Thank you for purchasing the Grandstream GXV3140 IP Multimedia Phone. The GXV3140 is designed for 
the high-end enterprise market and is easy to use and configure. It supports a broad range of audio codecs 

and H.264，H.263/H.263+ video codecs. Based on the SIP standard, it is interoperable with 3rd party SIP 

platforms. The GXV3140 takes full advantage of VoIP technology to allow plug and play communication 
anywhere in the world. 
 
This user manual will help you to understand how to configure and manage your GXV3140 IP Multimedia  
phone. It will also show you how to fully utilize features such as quick installation, conference calling, and 
Direct IP calling. 
 
 
GXV3140 Overview 
 
The GXV3140 is a next generation SIP-based IP Multimedia phone that supports a selection of high quality 
audio codecs and is compatible with the H.263/H.263+/H.264 video codecs. The GXV3140 supports high 
quality real-time video transmission on a 4.3” TFT color LCD even when under low bandwidth conditions 
(32kbps-1Mbps). The VGA camera’s lens is adjustable to allow high quality video conferencing. 
 
The GXV3140 embodies a sleek and elegant industrial design. The advanced telephony and video 
features, interoperability with third party SIP products and ease of use makes it an ideal IP Multimedia 
product for both the enterprise and consumer markets alike. 
 
 
Caution: Changes or modifications to this product not expressly approved by Grandstream, or operation of this 
product in any way other than as detailed by this User Manual, could void your manufacturer warranty. 
 
 
 
• This document is subject to change without notice. The latest electronic version of this user manual is 

available for download @ http://www.grandstream.com/user_manuals/GXV3140_User_Manual.pdf 

• Reproduction or transmittal of the entire or any part, in any form or by any means, electronic or print, for any 
purpose without the express written permission of Grandstream Networks, Inc. is not permitted. 

 

 

http://www.grandstream.com/user_manuals/GXV3140_User_Manual.pdf
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INSTALLATION 
 

EQUIPMENT PACKAGING 
 
The GXV3140 package should include: 

1. One GXV3140 Phone Main Case 
2. One Handset 
3. One Phone Cord  
4. One Universal Power Supply 
5. One Ethernet Cable 
6. One Phone Stand 
7. One Headset Dongle 
8. One Quick Start Guide 

 
 
SAFETY COMPLIANCES 
 
The GXV3140 phone complies with FCC/CE and various safety standards. The GXV power adapter is compliant 
with the UL standard. Only use the universal power adapter provided with the GXV package.  
The manufacturer’s warranty does not cover damages to the phone caused by unsupported power adapters. 
 

 
WARRANTY 
 
If you purchased your GXV from a reseller, please contact the company where you purchased your phone for 
replacement, repair or refund.  
If you purchased the product directly from Grandstream, contact your Grandstream Sales and Service 
Representative for a RMA (Return Materials Authorization) number before you return the product. Grandstream 
reserves the right to remedy warranty policy without prior notification. 
 
Warning: Please do not use a different power adapter as this may damage your phone. This type of 
damage is not covered by the warranty. 
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CONNECTING THE GXV3140 IP MULTIMEDIA PHONE 
 
Figure 1: Connecting GXV3140 

 

 
 
Table 1:GXV3140 Connectors 

1 SD Card Slot SD Card Slot 

2 USB Port USB devices may be connected via the USB port. For example, you can 
connect a USB flash drive to save captured pictures or use a USB keyboard 
or mouse for the built-in web browser. 

3 Headset Jack 3.5mm headset connector port 

4 RCA Video/Audio 
Jacks 

Voice/video output port which can be connected to external peripherals (e.g. 
TV).  

5 RJ11 Jack Phone handset connector port 

6 PC Ethernet Port 10/100Mbps RJ-45 port connecting to PC 

7 Network Ethernet 
Port 

10/100Mbps RJ-45 port connecting to Ethernet 

8 Power Jack 12V DC Power connector port 

 
WALL MOUNT 
 
The GXV3140 can be mounted on the wall; there are two slots on the back of the phone for wall mounting.  
See Figure 2 on the next page. 
 
 
Figure 2: Wall Mount for GXV3140  
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The phone can be mounted on the wall via the two slots on the back of the phone. 
 
PHONE STAND 
 
The GXV3140 can also be placed on the table via the phone stand.  The GXV3140 has two positions for 
the stand on the back of the phone; each position supports a different angle.  
 
Figure 3: Phone Stand for GXV3140 
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PRODUCT OVERVIEW 

 
Figure 4: Front, Side and Back View of GXV3140 

 

 

 
Table 2: GXV Key features at a glance 
Open Standards 
Compatible  
 

SIP 2.0, TCP/IP/UDP, RTP/RTCP, HTTP/HTTPS, ARP/RARP, ICMP, DNS (A 
record and SRV), DHCP, PPPoE, TFTP, NTP 

Interfaces 
2 10/100Mbps Ethernet Ports，1 USB（2.0）port，3.5mm headset port.

Extraordinary Audio 
Quality 

Advanced DSP for audio，Silence Suppression，VAD,CNG,AEC,AGC 

Extraordinary Video 
Quality 

Supports real-time video H.263/H.263+ and H.264 codec under low bandwidth 
(32kbps-1Mbps). 

Advanced Video 
Features 
 

4.3” digital TFT color LCD with 480x272 resolution, 45 degree rotating lens 
(perpendicular), Advanced VGA lens, auto focus, auto exposure, zoom (2x 
optical 2x digital),  Camera Block, PIP(Picture-in-Picture) and still picture 
capture/store. 
 

Feature Rich Traditional audio features: Caller ID, Call Waiting, Call Holding, Call Transfer, 
Do-Not-Disturb, Mute, Automatic dial.  
Built-in web browser, RSS news, Stock market update, Weather forecast, 
Internet Radio, Media Player, Picture browser, Games, Calculator, Alarm clock, 
IM chat, Document Manager etc… 
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Advanced Functionality Support for multiple lines, conferencing, headset, Intercom, AES encryption. 
 
 

Table 3：GXV3140 Hardware Specification 

Ethernet Port Dual switched 10M/100M auto-sensing Ethernet ports 
LCD 4.3” digital TFT color LCD 
Camera 

Tilt Capable 1.3M pixel CMOS camera with privacy shutter(VGA） 

Auxiliary Ports 
RCA Type Stereo & Media output port，3.5m headset port，1 USB port，1 SD 

card reader 
Exterior 

Black ABS plastic，30 buttons 

Universal Power Supply 
Input：100-240V AC 

Output：12V DC，1.2A 

US/Euro/UK/Australian style plug available. 
Dimension 7.87x7.32x1.57in/200x286x40mm 
Weight 1.87lb /0.85Kg 
Operating Temperature 32-104° F/0°–40°C 
Humidity 10-90% Non-Condensing  
Compliance FCC/CE/C-Tick 
 

Table 4：GXV3140 Technical Specifications 

Lines Three individual SIP accounts 
Protocol Support SIP 2.0, UDP/IP, PPPoE, RTP/RTCP, SRTP by SDES, HTTP, ARP/RARP, 

ICMP, DNS, DHCP, NTP/SNTP, TFTP. 
Display 4.3” digital TFT color LCD with 480x272 resolution  
Function Keys 

4 programmable soft keys: F1，F2，F3，F4. Line, mailbox, phonebook, mirror, 

call transfer, hold, conference, dial/send, speakerphone and five navigation 
keys. 

Network Interfaces Dual switched 10M/100M auto-sensing Ethernet ports, USB 2.0 port, 1 
audio/video output port (to synchronously output video to TV), headset jack. 

Device Management 
 

Layer 2 QoS (IEEE 802.1p/Q tagging-VLAN and Layer 3 QoS (DiffServ); Web 
interface or via secure (AES encrypted) central configuration file for mass 
deployment, keypad & adjustable 4.3 inch digital TFT Color LCD, Auto/manual 
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provisioning system, GUI interface, phone book, remote software 
(TFTP/HTTP) upgrade for deployed devices including those behind a 
NAT/firewall. 

Provisioning Support for automatic NAT/firewall traversal & remote automatic software 
upgrade and security, providing end-users with “zero configuration” and true 
“plug-and-play” functionality. 
Support for remote configuration monitoring and syslog. 
Configuration through LCD, web browser or an external configuration file. 
Support for IETF STUN NAT traversal and symmetric RTP; 
Static IP or DHCP. 

Audio Features 
Full duplex speaker，advanced DSP； 

Support G.723.1，G.729A/B,G.711μ/A (PCMU/PCMA), G.726- 

DTMF（In-audio, RFC2833，SIP Info）； 

Silence suppression，VAD，CNG，AGC，masking for packet loss/delay； 

AEC，AGC for Speaker；jitter buffer protocol 

Video Features Support for Jitter Buffer delay and packet loss concealment to enhance audio 
and video quality. 

Support for H.263/H.263+ and H.264 real-time video codecs（CIF or QVG）up 

to 30frames/sec, which ensures high quality video transmission even under 

low bandwidth conditions (32kbps-1Mbps)； 

4.3” digital TFT color LCD with 480x272 resolution, 45 degree rotating lens 

(perpendicular), advanced VGA CMOS camera and sensor； 

anti-flickering of images，auto focus，auto exposure，zoom (2x optical 2x 

digital ), PIP(Picture-in-Picture) , audio mute, camera block，call log，video 

phone book；screensaver，still picture capture/store（VGA），visual voice 

message indicator 
Call Handling Features 
 

Caller ID, call waiting ID, call waiting/flash, call transfer, call holding, call 
forwarding, Do-Not-Disturb, three-way conference, redial, automatic dialing on 
off-hook, automatic answering, call records, volume control, voice message 
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waiting indicator, downloadable custom ring tone. 

Caller ID（Privacy） 
Private header support for anonymous calls. 

Firmware Upgrade Configuration file authentication (before accepting changes); 
TFTP/HTTP upgrade support, allows users to specify different URLs for the 
server to download from.  

Advanced Server 
Features 

DNS SRV support, SIP server failure transfer, message waiting indicator and 
custom screensaver.  

Security 
MD5 and MD5-sess DIGEST encoding and authentication； 

Security protection: SIP over TLS and SRTP. 



USING THE GXV3140 IP MULTIMEDIA PHONE 

LCD 
When the phone is idle, the LCD screen will look similar to the figure below (The extension number may be 
different from case to case, depending on the network environment and the settings):  
 

Figure 5：GXV3140 LCD Idle Screen 

 

 
Press the F2 button underneath “Switch Screen” to switch to another display screen. (Shown in figure 
below): 
 
Figure 6: LCD IDLE screen displaying RSS News feed and Stock 
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Press F2 again to switch to a display screen that displays the calendar and weather forecast. 
 
Figure 7: LCD IDLE screen displaying Calendar and Weather forecast 

 

Table 5：LCD Icon Definition 

Type Icon Definition Note 

 Connected to the network  Network 

 Failed to connect to the network, 
the icon will flicker between yellow 
and gray. 

 

Line 1 Status  Line 1 is registered  
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 Line 1 is not registered The Account and line 
status are separate. 
Line status will only 
show busy or idle. 

 Line 1 is busy If Line 1 is in a call 

 Line 2 is registered  

 Line 2 is not registered  

Line 2 Status 

 Line 2 is busy If Line 2 is in a call 

 Line 3 is registered  

 Line 3 is not registered  

Line 3 Status 

 Line 3 is busy If Line 3 is in a call 

 
Account 1 Auto Answer  

 
Account 2 Auto Answer  

 
Account 3 Auto Answer  

 
Account 1 Call Forward 

 
Account 2 Call Forward 

Call related 

 
Account 3 Call Forward 

If configured to forward 
calls: unconditional 
forward, forward when 
busy or forward on no 
answer 
 

 

 

… 

Call Volume 

 

Volume setting, ranges from 0-9. 
The nine icons represent different 
volume levels. 

 

 
 

 
 

….  

Ring Volume 

 

Ring volume, ranges from 0-9 
 

 



 

GXV3140 USER MANUAL www.grandstream.com 
SOFTWARE VERSION 1.0.0.44 support@grandstream.com 
 

 Camera disabled.  

 Do-Not-Disturb (DND)  

 
Missed Call. If there is a new 
missed call, the icon will flicker. 
 

 

Phone Status 

 Mute  

 First Desktop（Small Layout） 

 Second Desktop（Small Layout） 

 First Desktop（Big Layout） 

 Second Desktop（Big Layout） 

Screen Layout Icon 

 Third Desktop（Big Layout） 

The Small layout can be 
selected in the 
Personalize/Screen 
Layout menu. 
 
The Big layout can be 
selected in the 
Personalize/Screen 
Layout menu. 
 

 The headset is in use and is off 
hook. 

 

 The headset is plugged in.  

 
The phone is on speaker.  

Audio Output 

 
The handset is off hook.   

 IM is not logged in  

 IM is logging in; the icon will flicker 
between blue and gray. 

IM 

 There is a new message on IM. 
The icon will flicker between blue 
and yellow. 

The icon is displayed at 
the right hand-side of 
the status bar. 
 

Applications 
 

Text message. The icon will flicker 
if there is a new unread text 
message. 
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  Alarm clock   

  Media（music/video）Player 
The icon is displayed at 
the right hand-side of 
the status bar. 

  Internet radio The icon is displayed at 
the right hand-side of 
the status bar. 

  Web browser The icon is displayed at 
the right hand-side of 
the status bar. 

External devices  SD card  

  USB flash drive.  

  USB keyboard  

  USB mouse  

 
 

Figure 8：GXV3140 Keypad 

 

Table 6：GXV3140 Keypad definition 

Key Definition 
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4 function/soft keys that correspond to the functions displayed on the LCD. 

 

 
Line/Account selection. Three independent SIP accounts may be configured, and 
the Line button can be used to choose the line/account to be used. 

 
Retrieve video/voicemail message or other messages. 

 

 
Phonebook 

 

 

 

 

 

 

 

 

 

 

 

Standard telephone keypad. The # key can act as a send key. 
In the input mode, if an English alphabet needs to be entered, press the 
corresponding numerical key multiple times. 
For example, if the user wishes to enter B, press 2 three times; if the user wishes 
to enter Y, press 9 four times. 
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Camera Loopback button. This button Enables or Disables the camera display on 
the local LCD. 

 
Call Transfer: Allows the user to transfer a call to another extension or number. 

 Places the call on hold 

 
Conference button - connects the caller/callee to the conference 

 
Sends a new number or redials the last number dialed. 
 

 
Turns the Speaker ON or OFF. 

 

 

Navigation Buttons: These arrows keys serve as up/down/left/right button when 
used in the GXV3140’s menus.  The middle button is used as the submit/select 
button.  
When the phone is idle, the up and down arrow can be used to increase/decrease 
the volume.  

 

 
MULTIPLE SIP ACCOUNTS AND LINES 
The GXV3140 supports up to 3 independent SIP accounts. Each account may have separate SIP servers, 
usernames and NAT configurations. Press the LINE button to view the status of the 3 lines and press the 
corresponding FUNCTION button to select the account to use for dialing out. When the phone is off-hook, 
press the LINE button to switch between different SIP accounts. 
 
For example, let’s say that you configure 3 SIP accounts: Account1, Account2, and Account3. The 
registration status of each account is displayed on the desktop. If the account is registered, the icon next to 
the account will be in yellow and purple. If the account is not registered, the icon next to the account will be 
gray with a red cross on it. When all the accounts are registered, press F1 to select Line 1, the user should 
hear a dial tone and the LCD will display Account1. Furthermore you can press F2 to select Line 2, or 
press F3 to select Account3. When the user presses the FUNCTION button, they will hear a dial tone and 
can start entering the number that they wish to call. 
 
Incoming calls through the three accounts will try to use the corresponding line. If this line is busy, the icon 
for the line (top-left hand corner) will be green. When a call comes in and the line is busy, the next idle line 
will be used while the icon for that line will flicker between blue and green.  
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HANDSET, SPEAKER AND HEADSET MODE 
The GXV3140 allows users to switch from the handset to speaker or headset by pressing the Hook Flash, 
the Headset FUNCTION button or the SPEAKER Button. 
 
 
 
 
 
MAKING A CALL 
There are several ways to make a call: 

1. Enter the number： 

• Take the handset off hook or use the speaker/headset，press the LINE button and select the 

desired account/line by pressing the corresponding FUNCTION button. 
• A dial tone is given, adjust account if necessary. 
• Enter the number 
• Press SEND 

2. Redial： 

When redialing, the phone will use the account that was used to call the last number dialed. 
Therefore, if the last number dialed uses the third account, the phone will also use the third 
account when redialing. 

• When the phone is idle, press the # or the SEND button. 
• When using the speaker/headset/handset, press the SEND button. 

 

3. By Call History： 

Enter the Menu by pressing the F1 button, and then select “Call history”. The LCD monitor will 
display all call history types: “Dialed calls”, “Received calls”, and “Missed calls”. Select the call 
history that you wish to view by using the up and down arrow keys and then select the 
corresponding FUNCTION button to dial the number or delete the record.  

 

4. By Phone Book： 

Enter the Menu by pressing F1, and then select “Phone Book”. The LCD screen will display the 
saved records in the phone book. Navigate to the phone book record with the arrow buttons, and 
call the number by selecting the FUNCTION button. At the same time, users may browse through 
or delete the phone book records. 
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5. By Messages: 
Enter the Menu by pressing F1, and then select “Messages”. The LCD screen will display the 
Message Inbox, Sent messages and Draft messages. Select the message and press F3 for 
“Options”, and then select “Dial” to dial out to the number.  

 
6. On-hook Dialing: 

Without lifting the handset off the hook, simply dial the number and press F3 to SEND. This 
phone will dial the number and the audio will be output via speakerphone. The phone will use the 
primary account to dial out.  

   
DURING CALLS 
 
ANSWERING CALLS 

1. Single Incoming call：When the phone rings, you can use the headset, handset or speaker to answer 

the call. The user may also press the SPEAKER button or the corresponding FUNCTION button for 
“Accept” on the LCD screen. 

2. Multiple Incoming Calls：Users will hear a call waiting tone while the LCD displays the number of the 

caller. At this moment, press the corresponding FUNCTION button for “Accept” to establish a 
connection with the new caller. This will put the previous call on hold, and users may press LINE 
button to switch between the lines 

3. Paging/Intercom: After the phone “beeps”, the call is automatically established through the speaker. 
(PBX / IP-PBX required) 
 

CALL HOLD/WAITING 

1. Call Hold：Press the HOLD button ( ) to place the call on hold. 

2. Call recover：Press the HOLD button again to return to the call, or press the “Resume” FUNCTION 

button. 

3. Multiple Calls：Put the current call on hold, press the LINE button to select another line or accept 

another call. When the line is busy the user hears a call waiting tone, notifying the user that a call is 
waiting. 

 
CALL TRANSFER 
1. Blind Transfer: Press the “CALL TRANSFER” button to place the other party on hold. The phone will 

display the following message: “Dial Number (Blind) OR Select Line (Attended)”. Dial the extension 
number and press F3 for “SEND”. This will transfer the call to the other party immediately. 
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2. Attended Transfer：Press the “LINE” button to select an idle line to use for attended transfer; this will 

place the other party on hold immediately. Dial the number that you wish to transfer to and after 
confirmation from the party, press the “CALL TRANSFER” button. The phone will display the following 
message: “Dial Number (Blind) OR Select Line (Attended)”. Press the “LINE” button and select the line 
on hold. 
 
 
 
 

NOTE: 

• To transfer calls across SIP domains, SIP service providers must support transfer across SIP domains. 

Blind transfer will usually use the primary SIP profile. 

• If the user enters the wrong number and wishes to cancel the transfer, just press the “CALL TRANSFER” 

button again to cancel the transfer. Or press “HOLD” key to hold the line and redo again. 
 
3-WAY CONFERENCE 
The GXV-3140 supports 3-way conferencing. 
1. Initiate a Conference Call: Place the first call on hold by pressing the “LINE” button to call the second 
party. Once you establish the call, press the “CONFERENCE” button then select the line on hold to bring 
three parties together. 
3. Cancel Conference: If after pressing the “CONFERENCE” button, a user decides not to conference 
anyone; press the corresponding FUNCTION key for “Cancel” to cancel the conference.  
4. End Conference: There are two ways to end a conference. The first way is to press “HOLD”, this 
breaks the conference and places both parties on hold, and the user can now speak to individual party by 
selecting the corresponding LINE. The second way is to simply hang up and terminate the call. 
 

VOICEMAIL（MESSAGE WAITING INDICATION） 

If the blue MWI LED icon is flickering on the upper right hand corner, it means that a new message is 

waiting. Press MSG  to retrieve the message (the button needs to be configured). By default, 

pressing the MSG button will transfer to the voicemail box of Line1; if the user wishes to enter the 
voicemail box of Line 2 or Line 3, the Line should be selected prior to pressing the MSG button. The IVR 
prompts the user through the message retrieval process. Select a particular line to see the messages for 
that account. 
 
Note: Each of the 3 lines has its own voicemail; the Voicemail number for each number may be set up in 
the “Voicemail ID” configuration. 
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MUTE 
1. During a call, the LCD screen will display “Mute”. Press the corresponding FUNCTION button to mute. 
2. After the “Mute” button is pressed, the LCD screen will display “Unmute”, when this button is pressed, 

the mute feature is cancelled. 



CALL FEATURES 
These are the feature codes for call features. To use the code, select the line you wish to use by pressing 
the LINE button and enter these feature codes. 
 
Table 7: Call Features 

Code Feature 

*30 Block Caller ID (for all subsequent calls) 

*31 Send Caller ID (for all subsequent calls) 
 

*50 Disable Call waiting (for all subsequent calls) 

*51 Enable Call Waiting (for all subsequent calls) 
 

*67 Block Caller ID (per call): Dial *67 + Phone/Ext. Number (no dial-tone in between). 
 

*82 Send Caller ID (per call): Dial *82 + Phone/Ext. Number (no dial-tone in between). 

*70 Disable Call Waiting (per call): Dial *70 + Phone/Ext. Number (no dial-tone in between). 

*71 Enable Call Waiting (per call): Dial *71 + Phone/Ext. Number (no dial-tone in between). 

*72 Unconditional Call Forward: Dial *72 + Phone/Ext. Number followed by the # key. Wait for a 
dial-tone and then hang up (dial-tone means input is successful). 

*73 Cancel Unconditional Call Forward: Dial *73 and wait for a dial-tone before hanging up. 

*90 Busy Call Forward: Dial *90 + Phone/Ext. Number followed by the # key. Wait for a dial- tone 
and then hang up. 

*91 Cancel Busy Call Forward: dial *91 and wait for a dial-tone before hanging up. 

*92 Delayed Call Forward: Dial *92 + Phone/Ext. Number followed by the # key. Wait for a dial-tone 
and then hang up. 

*93 Cancel Delayed Call Forward: Dial *93 and wait for a dial-tone before hanging up. 
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 GXV3140 WEB CONFIGURATION INTERFACE 
 
The GXV-3140’s embedded Web server responds to HTTP/HTTPS GET/POST requests. Embedded 
HTML pages allows users to configure the IP Multimedia Phone through a Web browser such as 
Microsoft’s IE or Mozilla Firefox (Java Script must be enabled).  
 

Figure 9: Web Browser Interface for GXV3140 

 
 

ACCESSING THE WEB CONFIGURATION INTERFACE 

The GXV3140 Web Configuration Interface URL is http://Phone-IP-Address, where the Phone-IP Address 
is the IP address displayed on the phone’s LCD screen. 
 
To access the phone’s Web Configuration Menu: 

• Connect the computer to the same network as the phone. 
• Make sure the phone is turned on and shows its IP-address on the LCD display. 
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• Open a Web-browser on your computer. 
• Enter the phone’s IP-address in the address bar of the browser. 
• Enter the administrator’s login and password to access the Web Configuration Menu.   
 
1. The Web-enabled computer has to be connected to the same sub-network as the phone. This can 

easily be done by connecting the computer to the same hub or switch as the phone is connected 
to. In absence of a hub/switch (or free ports on the hub/switch), please connect the computer 
directly to the phone using the PC-port on the phone. 

2. If the phone is properly connected to a working Internet connection, the phone will display its IP 
address. 
This address has the format: xxx.xxx.xxx.xxx, where xxx stands for a number from 0-255. You will 
need this number to access the Web Configuration Menu. e.g. if the phone shows 192.168.0.60, 
please enter “http://192.168.0.60” in the address bar of your browser. 

3. The default login name for the administrator is “admin”, the default administrator password is set 
to ”admin.” The default login name for end-users is “user” while the default user password is set 
to ”123.” 
NOTE: When changing any settings, always SUBMIT them by pressing the SAVE button on the 
bottom of the page. You must reboot the phone for the changes to take effect.  

DEFINITIONS 
This section describes the options in the Web configuration user interface.  As mentioned, you can log in 
as an administrator or an end-user. 

• Status: Displays the System info, Network status and Account status of the phone 
• Account (1~3): To configure each of the SIP accounts. 
• Advanced Settings: To set Generic settings, Call Features, Ring Tones, Time Settings, Video 

Settings, Network Resources and Browser Settings. 
• Maintenance: To Set Network Settings, Web Access, Upgrade and Provisioning, SysLog, 

Language and Capture Packets 
• Device Manager: Device configuration for LCD, Headset, Camera and TV Ports. 

 
 

STATUS PAGE DEFINTIONS 
Status/System Info 

Product Model Defines the product model: GXV3140. 

Hardware Revision  Hardware version number: Main Board, Interface Board 

PN Code (Part 
Number) 

This field contains the product part number 

Software Version • Program: This is the main firmware release number, which is always used for 
identifying the software (or firmware) system of the phone. 
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• Boot: Booting code version number 

• DSP: DSP code version number 

• Base: Base code version number 

• Core: Core code version number 

• GUI-A, GUI-B: GUI interface version number 

System Up Time This field shows system up time since the last reboot. 

 
Status/Network Status 

MAC Address The device ID, in HEX format. This is a very important ID for ISP troubleshooting.

Address Type This field shows the type of address configured: DHCP, Static IP or PPPoE. 

IP Address This field shows the IP address of the GXV-3140. 

Subnet Mask This field shows the subnet mask of the GXV-3140. 

Gateway This field shows the Gateway of the GXV-3140. 

DNS Server This field shows the DNS Server of the GXV-3140. 

NAT Type This field shows the type of NAT configured. 

 
Status/Account Status 

Account  Shows the status of the 3 accounts 

Number Shows the extension number of the SIP account. 

SIP Server Shows the URL/IP address and port of the SIP server 

Status Shows the status of the account. 

 
 
ADVANCED SETTINGS PAGE DEFINITIONS 
Advanced Settings/Generic Settings 

Lock Keypad for 
Update 

The default value is NO. If set to YES, the keypad will be disabled from making 
any updates. 

Local RTP Port This parameter defines the local RTP-RTCP port pair used to listen and transmit. 
It is the base RTP port for channel 0. When configured, for audio, channel 0 will 
use this port _value for RTP and the port_value+1 for its RTCP; channel 1 will 
use port_value+4 for RTP and port_value+5 for its RTCP. For video, channel 0 
will use port_value+2 for RTP and port_value+3 for its RTCP; channel 1 will use 
port_value+6 for RTP and port_value+7 for RTCP. The default value is 5004 
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Use Random Port When set to YES, this parameter will force random generation of both the local 
SIP and RTP ports. This is usually necessary when multiple GXV-3140s are 
behind the same full cone NAT. The Default setting is YES. (This parameter must 
be set to NO before Direct IP Calling will work) 

Keep-alive Intervals (s) This parameter specifies how often the GXV-3140 sends a blank UDP packet to 
the SIP server in order to keep the “pin hole” on the NAT router to open. The 
Default setting is 20 seconds. 

STUN Server The IP address or Domain name of the STUN server. STUN resolution results 
are displayed in the STATUS page of the Web UI. Only non-symmetric NAT 
routers work with STUN. 
Default STUN server: stun.ipvideotalk.com 

Use NAT IP The NAT IP address used in SIP/SDP messages. This field is blank at the 
Default settings. This should ONLY be used if your ITSP requires it. 

SSL Certificate This defines the SSL certificate needed to access certain websites. 

SSL Private Key This defines the SSL Private key. 

SSL Private key 
Password 

This defines the SSL private key password.  

 
Advanced Settings/Call Features 

Disable Call-Waiting The Default setting is No. If set to Yes, the call waiting feature will be disabled. 

Disable Call-Waiting 
Tone 

The Default setting is No. If set to Yes, the call waiting tone will be disabled. 

Disable Direct IP Call  The Default setting is No. If set to Yes, Direct IP calling will be disabled.  

 
Advanced Settings/Ring Tone 

Distinctive Ring Tone This feature lets you select up to 3 Distinctive Ring Tones that will be played for a 
specific Caller ID. 
The GXV will ONLY use selected ring tones for particular Caller IDs.  For all 
other calls, the default system ring tone will be used. 
If the server supports the Alert-Info header and standard ring tone set (like 
Bellcore) is specified, then the Caller ID field must be left “blank” and the ring 
tone will be used based on the info header from the server 

Call Progress Tones Using these settings, users can configure ring or tone frequencies based on 
parameters from the local telecom provider. By default, they are set to the North 
American standard. 
 
Frequencies should be configured with known values to avoid uncomfortable 
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high pitch sounds. 
Syntax: f1=val,f2=val[,c=on1/off1[-on2/off2[-on3/off3]]]; 
(Frequencies are in Hz and cadence on and off are in 10ms) 
ON is the period of ringing (“On time” in ‘ms’) while OFF is the period of silence. 
In order to set a continuous ring, OFF should be zero. Otherwise it will ring ON 
ms and a pause of OFF ms and then repeat the pattern. Up to three cadences 
are supported. 

Ring Cadence This defines the ring cadence for the phone. The default setting is: c=2000/4000;

 
Advanced Settings/Time Settings 

NTP Server This parameter defines the URL or IP address of the NTP (Network Time 
Protocol) server. The GXV3140 phone may obtain the date and time from the 
server.  
The default setting is ntp.ipvideotalk.com .  

DHCP Option 42 
override NTP server 

Select Yes for the user to allow DHCP Option 2 to override the NTP server if 
there is one on the LAN. The default setting is NO. 

Time Zone This parameter controls the date/time display according to the specified time 
zone. 

Self-Defined Time 
Zone 

This parameter allows the users to define their own time zone.  

 
Advanced Settings/Video Settings  

Video frame rate The Default value is 15 frames/second. The video frame rate is adjustable based 
on network conditions. 
Increasing the frame rate will increase the amount of data significantly therefore 
consuming more bandwidth. Lack of bandwidth will impair the video due to 
packet loss. 

Video bit rate The Default value is 128 kbps. The video bit rate is adjustable based on network 
conditions. 
Increasing the video bit rate may improve video quality if the bandwidth permits. 

Otherwise the video quality will be impaired due to packet loss 

Video Packet Size The Default value is 1400, range from 100 to 1400. 

It is recommended to use 600~800 if you have an Outbound Proxy or Media 
Gateway. 

Video Rate Control Frame or TMN8. The Default setting is Frame. 

TMN8 is good for bandwidths larger than 384kbps 
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Video Frame Skipping Skips bad video frames as they are received 

The Default setting is NO. 

 
Advanced Settings/Network Resources 

Weather Update This allows the user to set their preferred location for the weather forecast. 

City (Zip Code): Enter the zip code of the city the user wishes to receive weather 
updates. 

Refresh Interval (m): Set the interval for weather updates. 

Degree Units: Lets you specify the temperature to be measured in Fahrenheit or 
Celsius. 

RSS News Refresh Interval (s): The interval for information refreshing. 

Update Interval (m): The interval for information updating. 

RSS Feed (1~3): Enter the URL/IP address of 1-3 websites that the user 
subscribes to. 

Photo Album This allows users to configure their account login for Flickr, the online photo 
album service.  

Click on “ADD” and the user will be brought to another webpage for username, 
password and authorization. The user can choose to delete the account later if 
he/she desires. 

Last FM The user must register for a Last FM account or have an existing Last FM 
account. This setting allows users to configure their account login for Last FM. 

User Name: Enter the username for Last FM account. 

Password: Enter the password for Last FM account. 

Browser Settings Start Browser on Boot: Start the embedded mini browser in the LCD once the 
phone boots up. The default setting is NO. 

Browser Homepage: Sets the mini browser homepage.  

 
 
MAINTENANCE PAGE DEFINITIONS 
 
Maintenance/Network Settings 

Address Type This selects the type of IP address assigned: DHCP, PPPoE or Static IP.  

PPPoE When PPPoE is selected, the user needs to enter the following: PPPoE Account 
ID, PPPoE Password, PPPoE Service Name. 

Static IP When Static IP is selected, the user needs to enter the following: IP address, 
Subnet Mask, Default Gateway, Preferred DNS Server and Alternate DNS 
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Server. 

Preferred DNS Server This field sets the preferred DNS server for the user. 

Layer 3 Qos This field defines the layer 3 QoS parameter. It is the value used for IP 
Precedence, Diff-Serv or MPLS. The Default value is 0. 

Layer 2 QoS 
802.1Q/VLAN Tag 

This field contains the value used for layer 2 VLAN tagging.  The Default value 
is 0. 

Layer 2 Qos 802.1p 
Priority Value 

This assigns the priority value of the Layer2 QoS packets. The Default value is 0.

 
Maintenance/Web Access 

Access Method This defines the access method for web access: HTTP or secure HTTPS 
protocol. 

Port This defines the port for web access. By default, HTTP uses port 80 and HTTPS 
uses port 443. This field is for customizable web ports. 

Admin Password This defines the administrator password for web interface access. Only the 
administrator can configure the “Advanced Settings” and “Account x” pages. The 
password is case sensitive and the maximum password length is 25 characters. 

User Password This defines the user password for web interface access. 

 
Maintenance/Upgrade and Provisioning 

Upgrade Via This field allows the user to choose the firmware upgrade method: TFTP, HTTP 
or HTTPS. 

Firmware Server Path Defines the server path for the firmware server. It can be different from the 
Configuration server which is used for provisioning. 

Config Server Path This is the server path for provisioning; it can be different from the firmware 
server. 

Firmware File Prefix This field enables your ITSP to lock firmware updates. If configured, only the 
firmware with the matching encrypted prefix will be downloaded and flashed into 
the phone. 

Firmware File Postfix This field enables your ITSP to lock firmware updates. If configured, only the 
firmware with the matching encrypted postfix will be downloaded and flashed 
into the phone. 

Config File Prefix This field enables your ITSP to lock configuration updates. If configured, only the 
configuration file with the matching encrypted prefix will be downloaded and 
flashed into the phone. 
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Config File Postfix This field enables your ITSP to lock configuration updates. If configured, only the 
configuration file with the matching encrypted postfix will be downloaded and 
flashed into the phone. 

DHCP Option 66 
override Server 

The Default setting is YES. If DHCP option 66 is enabled on the LAN side, the 
TFTP server can be redirected. Please be very careful when configuring this as 
the redirection could break the phone if this happens during the firmware 
upgrade. 

Automatic Upgrade The default value is NO. Choose “YES” to enable automatic HTTP upgrade and 
provisioning. 

Automatic Upgrade 
Interval 

Defines the interval (in minutes) to check the HTTP/TFTP server for firmware 
upgrades or configuration files changes. 

Automatic Upgrade 
Rule 

Defines the rules for automatic upgrade: Always Check, when F/W suffix/prefix 
changes, Skip the Firmware Check.  

Authenticate Conf File Authenticate configuration file before acceptance. The Default setting is NO. 

Factory Reset Press the RESET button to factory reset the phone. 

 
Maintenance/Syslog 

Syslog Server The URL/IP address for the syslog server. 

Syslog Level Select the level of logging for syslog. The default setting is NONE. 

There are 4 levels: INFO, DEBUG, ERROR and WARNING. 

 
Maintenance/Capture Packet 

Capture Trace Press START to start capturing a trace. Press STOP to abort the capture 
process. 

View Trace Press LIST to view the list of captured traces. It will show the time the trace was 
captured. Click on the name to download and view the trace. 

Enable Application 
Debug 

When set to YES, the trace captured will contain debug messages.  

The default setting is NO. 

 
Maintenance/Language 

Language Selects the language setting for the phone.  
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SIP ACCOUNT CONFIGURATION PAGE DEFINITIONS  
The GXV3140 has three lines that can configure independent SIP accounts. Every SIP account has an 
individual configuration page. 
 
Account/Generic Settings 

Account Active Select YES to enable and use the Line. 

Account Name The Account name for the user that is displayed on the LCD screen. 

SIP Server The IP address of the SIP server or the given domain name of the VoIP service 
provider. 

SIP User ID User account information provided by the VoIP service provider; normally similar 
to a telephone number or an actual telephone number. 

Authenticate ID The authenticate ID for the SIP user. It can differ or be the same as the SIP user 
ID. 

Authenticate password The password that the GXV uses to authenticate with the ITSP (SIP) server. 
After it is saved, this will appear as blank for security reasons. The maximum 
length is 25 characters. 

Voice Mail UserID When this is configured, the user can dial to the voicemail server using the 
MESSAGE button. This ID is normally the feature code for Voice Mail. 
 

Name The Caller ID that will be displayed for the account. 

User ID is phone 
number: 

If the Video phone has an assigned PSTN number, this field should be set to 
“YES”. Otherwise, set it to “NO”. If “YES” is set, a “user=phone” parameter will 
be attached to the “From header” in the SIP request to indicate the E.164 
number. 

 
Account/Network Settings 

Outbound Proxy  
 

IP address or Domain name of the Outbound Proxy, or Media Gateway, or 
Session Border Controller. Used by the GXV3140 for firewall or NAT penetration 
in different network environments. If a symmetric NAT is detected, STUN will not 
work and ONLY an Outbound Proxy will work. 

DNS Mode The default is set to A Record. If the user wishes to locate the server by DNS 
SRV, the user may select SRV or NATPTR/SRV. 

NAT Traversal This setting decides whether the NAT traversal mechanism is activated. If it is set 
to “Yes” and STUN server is configured, the GXV3140 will route according the 
STUN server. 
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In this mode, the STUN client embedded in the phone will communicate with the 
appointed STUN server to examine which type of Firewall/NAT setting is 
employed. If the type of NAT detected is Full Cone, Restricted Cone or 
Port-Restricted cone, the phone will try to use public IP addresses and port in all 
the SIP and SDP messages. 
If the “NAT Traversal(STUN)” is configured to be “No, but keep-alive”, the phone 
will send an empty SDP packet (without payload data) to the SIP server once in 
20 seconds to keep the NAT port open. If an outbound proxy server is used, 
please configure this to be “NO”. 
 

Use RFC3581 
Symmetric Routing 

This configures whether RFC3581 symmetric routing is to be used or not. 

Proxy Require Notifies the SIP server that the unit is behind a NAT/Firewall. 

 
Account/SIP Settings 

SIP Registration Selects whether or not the GXV3140 will send a SIP Register message to the 
proxy; The default setting is YES. 

Unregister On Reboot If set to YES, the SIP user registration messages will be cleared on reboot. 
The default setting is YES. 

Register Expiration (m) 
 

This defines the expiration time of the registration in minutes. The default value 
is 50 minutes; the maximum value is 65535 minutes (approximately 45 days) 
and the minimum value is 5 minutes. 

Wait Time Retry 
Registration (s) 

The wait time for registration retry if registration fails. The default is set to 20 
Seconds. 

Local SIP Port The local SIP port for sending and receiving data. The default settings for 
Account 1/2/3 are 5060/5062/5064. 

Subscribe for MWI Default is set to No. When selected, a SUBSCRIBE for Message Waiting 
Indication will be sent out periodically. 

Session Expiration (s) Session Expiration is the time (in seconds) at which the session is considered 
timed out if no successful session refresh transaction occurs beforehand. The 
default value is 180 seconds. 

MIN-SE (s) The minimum session expiration (in seconds). The default value is 90 seconds. 

UAC Specify Refresher As a Caller, select UAC to use the phone as the refresher, or select UAS to use 
the Callee or proxy server as the refresher. 

UAS Specify Refresher As a Callee, select UAC to use the caller or proxy server as the refresher, or 
select UAS to use the phone as the refresher. 

Force INVITE The Session Timer can be refreshed using the INVITE or UPDATE methods. 
Select “Yes” to use the INVITE method to refresh the session timer 



 

GXV3140 USER MANUAL www.grandstream.com 
SOFTWARE VERSION 1.0.0.44 support@grandstream.com 
 

Enable 100rel Obtains a SIP temporary response (1xx) using PRACK method in order to 
support the PSTN network. Request for a reliable temporary response with 
100rel tag added to the first message request header. 

Caller Request Timer The default setting is Yes. If Yes is selected, the phone will use the session timer 
when it makes outbound calls if remote party supports session timer. 

Callee Request Timer If Yes is selected, the phone will use the session timer when it receives inbound 
calls with session timer request. 

Force Timer If Yes is selected, the timer will be activated even if the other party does not 
support session timers. If No is selected, the timer will be activated only if the 
other party supports the timer. To disable the timer, Caller Request timer, Callee 
request timer and Force Timer should all be set to No.  

SIP Transport Selects the SIP transport method. There are three types: TCP, UDP and TLS. 

Symmetric RTP Selects whether or not RTP is supported.  

Support SIP Instance 
ID 

Selects whether or not SIP Instance ID is supported.  
 

Validate Incoming 
Messages 

This configuration selects whether or not the incoming messages should be 
validated. 

SIP T1 Timeout This configures the timeout period for SIP T1. The default setting is 0.5 Seconds

SIP T2 Interval This configures the time interval for SIP T2. The default setting is 4 seconds. 

Remove OBP from 
route 

The SIP Extension notifies the SIP server that it is behind a NAT/firewall. 

 
Account/Codec Settings 

Enable Video 
--YES：Accepts all incoming video, this is the default setting； 

--NO：video is disabled. 

DTMF Assigns the mechanism to send DTMF. There are three supported modes: in 
audio (with DTMF as audio signals), through RTP and through SIP INFO. 

DTMF Payload Type Sends DTMF using RFC2833. The default is 101. 

Preferred Vocoder This products supports up to 5 different Vocoders: including G.711(a/μ)

（PCMU/PCMA）,GSM,G726-32k,G.723.1,G.729A/B and iLBC 

When this has been configured, the system will select the preferred vocoder 
from the list and the same order is sent with the SDP messages. 
 
The user can change the preferred vocoder priority order by toggling with the up 
and down buttons. It is recommended to use the default setting “PCMU”; if other 



 

GXV3140 USER MANUAL www.grandstream.com 
SOFTWARE VERSION 1.0.0.44 support@grandstream.com 
 

vocoders are chosen, there could be an audio transmission error. 

Preferred Video Coder 
Selects the preferred video codec between H.264，H.263 or H.263+. It is 

recommended to use H.264 

H.264Payload type Selects the dynamic H.264 codec payload type (ranges from 96-127). The 
default setting is 99 

H.263+ Payload type Selects the H.263+ codec payload type (ranges from 96-127). The default 
setting is 103 

SRTP Mode Select to Enable SRTP mode. The default is set to Disable. 

Silence Suppression This controls the G723/G729 silence suppression/VAD. If set to YES, when no 
audio is detected, the phone will send a small number of VAD packets (instead of 
audio packets). If Set to NO, this feature is disabled. The default setting is NO. 

Voice Frame per TX This configures the number of voice frames transmitted per packet. (It is 
recommended to set this based on the Ethernet IS packet limitation – 1500 Byte 
or 120kb/s) 
When configuring this, it should be noted that the “ptime” value for the SDP will 
change with different configurations here. This value is related to the codec used 
and the actual frames transmitted during the in payload call.  
 
For example: if the codec is configured to be G.723 and “Voice Frames per TX” is 
set to 2. Then in the INVITE request, the “ptime” value for SDP will be 60 ms. 
This is because the G723 voice frame is 30 ms. Similarly, if the setting is 2 and 
the codec is G729 or G711 or G726, the “ptime” value for SDP in the INVITE 
request will be 20 ms. 

If the voice frames per TX configuration exceeds the maximum value allowed, 
the phone will choose the preferred codec and use the maximum value allowed. 

The maximum values: For PCM is 0 frames (x10ms) ; for G76 is 20 frames (x10 
ms); for G723 is 32 frames (x30 ms); for G728/G728 is 64 frames (x10ms) and 
64 frames (x2.5 ms) respectively. 

Adjusting these values will also change the jitter buffer. The phone has an 
algorithm for setting the jitter buffer and the jitter buffer rate is around 20-200ms. 

For end-users, it is recommended to use the default setting, as incorrect settings 
may influence the quality of audio. 

G723 Rate This defines the encoding rate for G723 vocoder, and can be 6.3Kb/s or 5.3Kb/s. 
Please confirm with your service provider.  

Jitter Buffer Type Users can select either Fixed or Adaptive based on network conditions. The 
default is Adaptive. 
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Jitter Buffer Length User can select Low, Medium, or High based on network conditions. The default 
is Medium. 

Account/Call Settings 

Dialing Prefix Sets the prefix added to each dialed number. 

Dialing Plan Dial Plan Rules: 
1. Accepted Digits: 1,2,3,4,5,6,7,8,9,0 , *, #, A,a,B,b,C,c,D,d 
2. Grammar: x - any digit from 0-9; 

a) xx+ - at least 2 digit numbers 
b) xx. - only 2 digit numbers 
c) ^ - exclude 
d) [3-5] - any digit of 3, 4, or 5 
e) [147] - any digit of 1, 4, or 7 
f) <2=011> - replace digit 2 with 011 when dialing 
g) | - the OR operand 

 
• Example 1: {[369]11 | 1617xxxxxxx} 
Allow 311, 611, and 911 or any 10 digit numbers with leading digits 1617 
• Example 2: {^1900x+ | <=1617>xxxxxxx} 
Block any number of leading digits 1900 or add prefix 1617 for any dialed 7 digit 
numbers 
• Example 3: {1xxx[2-9]xxxxxx | <2=011>x+} 
Allows any number with leading digit 1 followed by a 3 digit number, followed by 
any number between 2 and 9, followed by any 7 digit number OR Allows any 
length of numbers with leading digit 2, replacing the 2 with 011 when dialed. 
 
3. Default: Outgoing – {x+} 
Allow any length of numbers. 
 
Example of a simple dial plan used in a Home/Office in the US: 
{ ^1900x. | <=1617>[2-9]xxxxxx | 1[2-9]xx[2-9]xxxxxx | 011[2-9]x. | [3469]11 } 
Explanation of example rule (reading from left to right): 
• ^1900x. - prevents dialing any number started with 1900 
• <=1617>[2-9]xxxxxx - allows dialing to local area code (617) numbers by 
dialing 
7 numbers and 1617 area code will be added automatically 
• 1[2-9]xx[2-9]xxxxxx |- allows dialing to any US/Canada Number with 11 digits 
length 
• 011[2-9]x. - allows international calls starting with 011 
• [3469]11 - allow dialing special and emergency numbers 311, 411, 611 and 911
Note: In some cases where the user wishes to dial strings such as *123 to 
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activate voice mail or other applications provided by their service provider, the * 
should be predefined inside the dial plan feature. An example dial plan will be: 
{ *x+ } which allows the user to dial * followed by any length of numbers. 

Early Dial The default setting is NO. Only use this if the proxy supports the 484 response. 

Refer to Use Target 
Contact 
 

The default is NO. If set to YES, then for Attended Transfer, the “Refer-To” 
header uses the transferred target’s contact header information. 
 

Auto Answer The default setting is NO. If it is set to YES, the GXV3140 will play a “beep” 
sound and answer the phone automatically on the speaker. 

Send Anonymous If set to YES, the “From” header in the outgoing SIP messages will be set to 
anonymous to block the caller ID from displaying. The default setting is NO. 

Anonymous Call 
Rejection 

The default setting is NO；If set to YES，any anonymous call will be rejected（with 

486Busy message） 

Account Ring Tone There are four ring tones to choose from: 
1 system ring tone: After selecting this, all calls will have the same ring tone. 
3 custom ring tones: The phone will have different ring tones according to the 
caller. 
 

Special Feature The default setting is Standard; different features can be selected depending on 
the user needs. 

Enable Call features The default is set to YES. If set to NO, the call features are disabled. 

Call Forward 
Unconditional 

Sets the number to forward to unconditionally. 

Call Forward When 
Busy 

Sets the number to forward to when busy. 

Call Forward When No 
Answer 

Sets the number to forward to when no answer. 

Delayed Call Forward 
Wait Time (s) 

The wait time before transferring the call to another extension or to voicemail; 
the default setting is 20 seconds. 

No Key Entry Timeout 
(s) 

Defines the time out duration on no key entry. 
Default setting is 4 seconds. 

Use # as Dial Key Selects whether or not # is used as Send. 

 
 
 
 



 

GXV3140 USER MANUAL www.grandstream.com 
SOFTWARE VERSION 1.0.0.44 support@grandstream.com 
 

DEVICE MANAGER PAGE DEFINITIONS 
 
Device Manager/ LCD 

Screen Saver Timeout 
(m) 

This sets the lapsed idle time needed for the screen saver to appear. The default 
setting is 5 minutes. 

Screen Saver Interval 
(s) 

The screen saver is a picture slide show. This defines the frequency to change 
the picture on the screen for the screen saver.  
The default setting is 10 seconds. 

LCD Auto Power Off 
Time (m)  

This defines the lapsed idle time needed for the LCD to power off automatically 
in order to save power. The default setting is 15 minutes. 

 
Device Manager/HeadSet 

Headset TX Gain (dB) Transmission gain. It’s a headset setting to control the voice intensity 

Headset RX Gain (dB) Receive gain. It’s a headset setting to control the voice intensity. 

 
Device Manager/Camera 

Zoom mode Select the desired camera zoom mode (Tele, optical, digital). Can adjust local 
video zoom either in mirror mode or during the call (on the fly) by pressing the 
Left or Right Arrow Key 

Exposure Select the desired Camera Exposure mode based on surroundings. The default 
setting is set to Auto 

Color Mode Select the desired Camera Color Mode (Color or Monochromatic). The default 
setting is set to Color 

White Balance Select the desired Camera White Balance to be automatic or Fixed. The default 
setting is set to Auto 

Lens Correction Correct Camera Lens noise. Default is set to YES. 

It is recommended to set this parameter to YES to reduce camera lens noise and 
improve video quality. 

 
Device Manager/TV Output 

TV Output Select the desired TV Output type (PAL or NTSC). 
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SAVING THE CONFIGURATION CHANGES 
After users makes changes to the configuration, press the “Save” button in the Configuration Menu. The 
web browser will then display a message window to confirm the saved changes. Reboot the phone for the 
new settings to take effect. 

REMOTE REBOOT  
Press the “Reboot” button at the top right-hand corner of the configuration menu to reboot the phone 
remotely. The web browser will then display a message window to confirm with the user if they wish to 
reboot the phone or not. Click on “Yes” and the phone will reboot. Wait 30 seconds to log in again. 
 

CONFIGURATION THROUGH A CENTRAL SERVER 
The Grandstream GXV3140 can be automatically configured from a central provisioning system. 
 
When the GXV3140 boots up, it will send TFTP or HTTP request to download a configuration file, 
“cfg000b82xxxxxx”, where “000b82xxxxxx” is the MAC address of the GXV3140. 
 
The configuration data can be downloaded from the central server via TFTP or HTTP/HTTPS. A service 
provider or an enterprise with larger deployments of Grandstream devices can easily manage the 
configuration and service provisioning of individual devices remotely from a central server. 
 
Grandstream has a central provisioning system called GAPS (Grandstream Automated Provisioning 
System). GAPS supports automatic configuration of Grandstream devices. GAPS uses enhanced (NAT 
friendly) TFTP or HTTP (thus no NAT issues) and other communication protocols to communicate with 
each individual Grandstream device. 
 
Grandstream provides GAPS service to VoIP service providers. GAPS can be used for either simple 
redirection or with certain special provisioning settings. At boot-up, Grandstream devices by default point 
to the Grandstream provisioning server (GAPS). Based on the unique MAC address of each device, GAPS 
will provision the devices with redirection settings so that they will be redirected to customer’s TFTP or 
HTTP server for further provisioning. Grandstream also provides the GAPSLITE software package which 
contains our NAT friendly TFTP server and a configuration tool to facilitate the task of generating device 
configuration files. 
 
The GAPSLITE configuration tool is now free to end users. The tool and configuration templates are 
available for download from http://www.grandstream.com/configurationtool.html 
 



LCD MENU AND FEATURES 
The GXV3140 has a user-friendly LCD Menu and multiple features that provide the users with convenient 
tools/applications for both work and personal entertainment. In other words, the GXV3140 acts as your 
personal assistant in many different ways. The LCD MENU and Features will be explored in more detail 
below. 

 
PHONE BOOK FEATURES 
Users can manage their contacts through the phone book. The phone book supports features such as 
adding, deleting, modifying contacts as well as downloadable phone book from the TFTP/HTTP server. To 
access the phonebook, the user can select the OK button or F1 (soft key corresponding to MENU) to 
access MENU and select Phonebook. The user may also access the phonebook with the Phonebook 
button on the phone. 

 

Select the Phone book to display the figure below: 
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As shown in the figure above, every contact contains an Extension number, Phone number, Mobile number, 
Fax number and the group it belongs to. On the lower right hand corner, it shows that the total capacity of 
the phone book is 500 contacts, as well as the number of used contacts. The user may dial the contact by 
pressing F1, and can search for a contact by pressing F2. When searching, the user needs to enter the 
user name to search and press OK to confirm. Press F3 to access “Options”, shown in the figure below:  

 

As shown in the figure above, Select “New” to add a new contact; Select “Edit” to modify an existing entry. 
The screen will display the figure below.  Users can add the entry to the phonebook and associate a 
picture taken by the screenshot feature as a thumbnail image for the contact.  
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In “Options”, select “Delete” to delete the contact, select “Delete All” to delete all of the contacts in the 
phone book; Select “Download” and the screen will display the following: 

 

 
In order to complete the download of a phonebook from a server, users should configure the Download 
mode and the URL/IP address of the Download server. After it is configured, select the “Download” button 
next to “Download now” to start downloading.  
 
Note: If the user is downloading from a local server, please ensure that the TFTP/HTTP settings are 
correct. 

 
CALL HISTORY 
 
Users may access the call records of the phone through the Call History. The Call History allows the user 
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to view and manage all calls (Dialed, Received, and Missed). Access the MENU by selecting F1 and select 
Call History, as shown in the figure below:        

 

Press F1 to Select the Call History, and you will enter a screen similar to the one below: 

 

 
As shown in the figure above, each user can choose to Dial, Save or Delete a Call Record. The Dial option 
will allow you to perform a re-dial or dial out to the number. The Save option will save the number to the 
phone book. 
      
MESSAGES   
The message feature is a text message feature (only English is supported at the moment). If two 
GXV3140s are registered on the same SIP server, text messages can be sent/received between the two 
parties. Similarly, if other IP products support this feature, the text message feature can also be used to 
send/receive messages between the device and the GXV3140. To access this feature, press F1 to select 
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Menu and then select Messages (as shown in the figure below): 

 

 
Press F1 to Select Messages. The screen should look similar to the one below: 

 

 
As shown in the figure above, users can create, view and manage their messages. When the user presses 
F3 to select “Options”, the user can dial the number of the sender, save the number of the sender, or delete 
the message(s). 
When the user receives a message, the following notification will show up on the LCD screen: 
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Press F3 to Select OK. This will open the message for the user to view. 

 

   
As shown in the figure above, the users can choose to “Reply”, “Forward” or “Delete” the message.   
        
CALL FEATURES 
 
The Call Features menu allows the user to configure Call Forwarding methods (Forward unconditionally, 
Forward when busy, Forward on no answer) and other features such as Auto-Answer, Call Waiting and 
DND. Users can configure the three accounts to different call forwarding schemes. To access call features, 
select F1 for MENU and select Call Features (as shown in the figure below): 
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Press F1 to Select Call Features and the following screen will be displayed: 

 

 
Other features include configuration for Auto Answer, Do Not Disturb, Call Waiting, Call Waiting Tone, and 
Direct IP Call (as shown in the figure below): 
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After the settings are configured, select “Save” to save and activate the settings.   
 
 
WEB BROWSER 
 
The GXV3140 provides users with a full HTML Web Browser for internet browsing. This is accessible by 
pressing the F1 button to load the MENU, and then select Web Browser (as shown in the figure below): 

 

 
 

After selecting OK, it may take several seconds to load the web browser. The LCD screen should look like 
the figure below when the web browser is loading: 
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When the web browser has finished loading, a default page displaying “Hello, welcome to GXV3140” 
shows up on the screen. 

 

Users can then press F4, corresponding to the “Options”, to move “Forward” and “Backward” on web 
pages. By selecting “URL” under “Options”, the user can enter the URL of a website. The user can press 
the F3 button which corresponds to the Tab option to toggle the curser. Similarly, users can choose 
“Zoom“ under “Options” to zoom in and zoom out of a webpage. Select “Exit” to exit the web browser. The 
figure below shows the screen of the web browser while visiting a website: 
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MULTIMEDIA 
 
The GXV3140 provides Multimedia applications such as Internet Radio, Media player, Photo viewer, Photo 
album, Gstris and Online Music. 
 
Press F1 to select the MENU and scroll to Multimedia (as shown in the figure below): 

 

 
Select Multimedia by pressing the OK button or “Select”. The multimedia features are shown in the 
figure below: 
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 INTERNET RADIO 

 
As shown in the figure above, select F1 or OK to load the Internet Radio application. The channels are 
divided into the following categories: My Favorites, Talk Channels, Music Channels, Sports Channels, 
Ethnic Channels and Local Radio. The users may select the channels according to their preferences. 
The screen will look like the figure below: 

 

      
As shown in the figure above, users can then press the F1 button to adjust the volume. 
From the “Options” button (F3), users can "Open an URL" or "Open URL list" for other Internet Radio 
stations. The user may also Play/Stop, Mute and Minimize the Internet radio.  
The user can press F4 to Exit the Internet Radio application. 
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In addition, users may configure “My Favorites” by pressing F2 button for “Control”. This would bring 
out a toolbar, where users can add/delete/modify and navigate through the “My Favorites” playlist (As 
shown in the figure below). 

 

 MEDIA PLAYER 
 

The GXV3140 Media Player allows users to play music files through the GXV3140. To access the 
Media Player, select MENU->Multimedia-> Media Player. (As shown in the figure below): 

 

 
Press the OK button or F1 to select the Media Player. 



 

GXV3140 USER MANUAL www.grandstream.com 
SOFTWARE VERSION 1.0.0.44 support@grandstream.com 
 

 

 
As shown in the figure above, press F1 to adjust the volume of the media player (Navigate by using 
the Up and Down buttons). Press F2 to enable the “Tab” option, this allows the user to move the 
cursor between the four buttons: “Previous”, “Play”, “Stop” and “Next”.  
Press F3 for “Options”.  Users can perform the following operations on the playlist: Add, Remove, Up, 
Down, Delete and Save. Users can also select the channel for output: Headset, Speaker and Stereo. 
Configurations such as Loop Play, Full Screen, Mute and Minimize can also be found here. Press F4 
to exit. 

 
 PHOTO VIEWER 

The GXV3140 features a Photo Viewer which allows users to conveniently view their photos. This is 
accessible through Menu->Multimedia->Photo Viewer (as shown in the figure below). 
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Press the OK button or F1 to Select the Photo Viewer. After the application loads, the user may select 
to view pictures from different folders: 

 

 
The screen will look similar to the figure below when the user loads any picture from a folder (For 
example, open the first picture from the “screenshot” folder).  

 

Users can choose F1 or F2 to select the “Previous” or the “Next” picture. Press F3 for “Options”, 
Users can also Zoom, Rotate (Clockwise, Counter Clockwise), Flip (Vertical Flip, Horizontal Flip) the 
picture as well as display the pictures in a slideshow.  

 
 

 PHOTO ALBUM 
 

Users can upload, view, or search for photos from online photo albums. The photo album can be 



 

GXV3140 USER MANUAL www.grandstream.com 
SOFTWARE VERSION 1.0.0.44 support@grandstream.com 
 

accessed by selecting MENU->Multimedia->Photo Album (as shown in the figure below): 

 

 
Press F1 to “Select” Photo Album. After the Photo Album is loaded, the following screen will appear; 
the user can choose which online photo album to use and press Start to begin activating it. 
 

 

Users must register for an account with a photo album service provider (i.e. Photobucket, Flickr, 
Phanfare) or use an existing account. For example, when Flickr is selected, users will need to “Add” 
an Account before they can upload local photos, view online photos and search for photos on Flickr. 
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 GSTRIS 

The GXV3140 provides interactive games for your entertainment. Under Menu->Multimedia, 
choose Gstris (As shown in the figure below).  

 

     
 

Access the Gstris application by pressing F1 (corresponding to Select) or the OK button. Press the F1 
and F2 to start/stop or pause the game (as shown in the figure below). 
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    ONLINE MUSIC 

 
The GXV3140 also provides an Online Music streaming application. Users must have a pre-existing 
account with LastFm before listening to online music through the GXV3140.  Users can also select 
their preferred music genre and listen to it online. To access the Online Music, select 
MENU->Multimedia-> Online Music (as shown in the figure below): 

 

   
 

Press F1 to “Select” Online Music. After the application loads, the user must first set up their account 
by accessing Options-> Settings, where the username and password for LastFM will be prompted. 
The user can then select the musical style that they prefer from the list of available musical styles.  
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Press F1 to adjust the volume (see the figure above) and press F3 for “Options”. In “Options”, there 
are several settings: the Play/Stop option will control the music, the Next option will skip the current 
song and play the next one, the Output option allows you to choose the output channel (Headset, 
Speaker, Stereo), Mute and Minimize. 

 
OFFICE TOOLS 
 

The GXV3140 provides a collection of useful office tools for users and can be accessed via MENU. 
These include the following features: Calendar, Alarm Clock, Weather Update, RSS News and Stock 
update. 
 
These features will be introduced in more detail below: 
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 CALENDAR 

 
This feature includes adding an event to the calendar, and can be accessed by pressing the F1 button 
corresponding to the “Add an event” option on the LCD (as shown in the figure below). 

 

 
 

As seen in the figure above, users can press F1 to “Add New Event”, where events such as birthdays 
may be added to the calendar. Press F2 for “Tab”, this allows the curser to move from 
year/month/date on the calendar, so that the date can be adjusted accordingly. Press F3 for “Options”, 
where users may view, delete or delete all events. Press F4 to exit the calendar. 

 
 ALARM CLOCK 

 
The GXV3140 provides users with a flexible alarm clock application. This application allows users to 
configure a custom alarm tone and configure the alarm time in detail to suit their needs (as shown in 
the figure below):    
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 CALCULATOR 
 
The GXV3140 also includes a Calculator application. To operate the calculator, press the 
corresponding number on the keypad. The arithmetic operations (e.g. add, subtract, multiply, 
divide) are defined by the corresponding arrow buttons.  

 

 
 WEATHER UPDATE 

 
The GXV3140 also includes a weather updates application that provides users with the most up to 
date information on the weather forecast.  Users may set the City (Zip code) to display the 
weather update for that particular city. In addition, users may also define the refresh interval time 
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(in minutes) and the preferred temperature units. 

 

 
 RSS NEWS 

 
The GXV3140 allows users to subscribe to different RSS feeds. The GXV3140 supports up to 3 
customized feeds (as shown in the figure below). The user is able to subscribe to news that is 
relevant to the topic of interest. You can also configure the refresh time of the RSS feeds: 

 

 
 

 DIRECT IP CALL 
 

Another key feature supported on the GXV3140 is Direct IP Calling. In the IP address field, enter 
the IP address of the other party and press the F3 key which corresponds to the “SEND” option on 
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the LCD as shown in the next figure:   

 

 
 IM 

 
The GXV3140 provides support for the following Instant Messaging services: Google Talk, MSN, 
QQ and Yahoo. Users must have a pre-existing account in order to start using the Instant 
Messaging feature. Users may manage their accounts by going to Options->Accounts->Manage 
Accounts (as shown in the figure below).  

 

 
Users will be prompted for login information for the Instant Messaging service of their choice as 
seen in the figure below. After the user logs in, they can begin to use the instant messenger to 
chat to their contacts online. 



 

GXV3140 USER MANUAL www.grandstream.com 
SOFTWARE VERSION 1.0.0.44 support@grandstream.com 
 

   

 
 

 FILE MANAGER 
 

The GXV3140 provides a file manager as a tool to manage files such as music, pictures and 
documents. Users can manage their documents efficiently through the File Manager.  As shown in 
the figure below, users can access different folders to manage their files. Ringtones and screenshots 
are stored in separate folders. If a USB device is connected, its contents will also be displayed in the 
File Manager. 

 

Users can copy files by pressing Options-> Copy, and after copying they can choose to paste the 
files to the desired directory by selecting Options-> Paste.  

 
 STOCKS 
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The GXV3140 includes a Stock Market monitoring application that conveniently retrieves current 
information regarding the stock market. 

 

As shown in the figure above, the users can use the “Add Stock” option by pressing F1. This adds a 
new stock to the list after you enter the stock symbol. 
Users can refresh the contents by pressing F2 for ‘Refresh” and press F3 for “Options” to delete or 
delete all stocks. Also, in Options->Settings, users can define the refresh interval, update interval, 
color option and enable/disable images. 
 

 CURRENCIES 
 

Users can use this feature to perform currency conversions. Users must enter the currency to convert 
from as well as the currency to convert to. Pressing F3 selects “OK” and starts the conversion process 
(as shown in the figure below): 
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SETTINGS 
 

The System Settings allow users to configure settings for Accounts, Network, Time, Display, 
Maintenance and the Camera. To access the system settings, press F1 to open the MENU and select 
Settings. 

 
 ACCOUNTS SETTINGS 

This menu lets users configure the three SIP accounts; the same configurations may be completed by 
accessing the web configuration interface. The LCD account setting page is shown in the figure 
below:  

 

 
 
 

 NETWORK SETTINGS 
This screen allows users to configure the various network connection settings as well as the 
VLAN settings.  
Users may choose to use DHCP, PPPoE or Static IP (as shown in the figure below):   
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In the “Other” page, users may choose to set the Preferred DNS server, Layer 3 QoS, Layer 2 
QoS 802.1Q/VLAN tag and Layer 2 QoS 802.1 priority value. 
 
 
 

 
 TIME SETTINGS 

The GXV3140 allows the time to be updated automatically through an NTP Server. Users 
must define the Time Zone or use a Self-defined Time Zone. You can also specify the display 
format for the time and date. 

 

 
 

 DISPLAY SETTINGS 
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This screen allows the user to adjust the LCD Backlight brightness, LCD Contrast, and LCD 
Saturation. In addition, users may configure the TV OUT mode (NTSC or PAL) here. 

 

       
Note: After setting TV out to an external source, the phone LCD screen will black out. Please 
make sure that you have plugged in the external output source before selecting this option. To 
return the display to the LCD menu, log into the web browser interface and disable TV Out in 
“Device Manager” -> “TV Output”. Otherwise, you will need to reboot the phone to enable the 
LCD screen. 

 
 

 MAINTENANCE 
There are three tabs on the Maintenance setting screen: Upgrade, Factory Functions and 
Debug. Users can configure the upgrade mode and firmware server IP address/URL on the 
upgrade tab. Once this is saved, users can choose to reboot the phone to upgrade the 
firmware. Similarly, a factory reset can be performed on the Factory Functions tab. A more 
detailed step-by-step guide will be given in the “Restore to Factory Default Settings” section 
that follows. 
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The Factory Functions page provides some testing diagnostics for the LCD, camera and 
audio on the GXV3140. (As shown in the figure below) 

    

The Debug page (as shown in the figure below) contains the built-in debug tools for the 
GXV3140. The debug tools make it more convenient to obtain corresponding information and 
traces when the system encounters problems. To start capturing traces, users need to Enable 
Application Debug and press the Start button next to the Capture Packets option. The 
captured traces are available for download through the web configuration interface and can 
be sent to Grandstream support for troubleshooting. 
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 CAMERA 
This screen allows the user to modify the camera settings for the GXV3140. Settings such 
as Color Mode, White Balance, Flicker Control and Lens Correction can be configured. (As 
shown in the figure below) 

 

 
PERSONALIZE 
  

Users may personalize the phone by selecting their preferred screen layout, soft key function, screen 
display and language settings. To access Personalize, press F1 for MENU, toggle to Personalize and 
press the OK button to select it.  
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 SCREEN LAYOUT 
Users can choose between Small Layout, Big Layout, or Custom Layout (by uploading an 
XML file) by toggling between the Left and Right buttons.   

 

 
 SOFTKEY 

Users can define the soft/function key functions of the Main Screen and Call Screen. There 
are several soft key functions that the user can select for the 4 function keys. 

 

Note:  Selecting the “Snapshot” option for one of the softkey functions for the Call Screen lets 
you capture a snapshot of the remote party during the call.  This picture will be saved in the 
“screenshot” folder and can be used as a picture icon for the contact in the Phone Book.  

 
 SCREEN SAVER 

Users can personalize the phone by selecting the screensaver and the desktop background. 
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The interval and the timeout period can also be specified here. 

 

 
 LANGUAGE 
This screen allows users to select the preferred language.  Users can download the 
corresponding Language File from the TFTP/HTTP server to expand to the language selection 
menu. 

 

 
 MY PROFILE 

 
This screen allows users to configure the login username and password for the phone. 
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 TONES 
This screen allows users to configure the alarm tone and the event alert tone 
for the GXV3140. 

 
 

INFO 
This screen displays the System, Network and Account information. 
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System information such as Product Model, Hardware Version, Part Number, System Up Time 
and Software Version are displayed here.     

 

 
As shown in the figure above, users can view the Network Information: MAC address, Address 
Type, IP address, Subnet Mask, Gateway, DNS Server and NAT Type. 
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The number and the status of the three SIP accounts can be viewed here. 
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SOFTWARE VERSION UPGRADE 
The GXV3140 can be upgraded via TFTP/HTTP/HTTPS by configuring the URL/IP Address for the 
TFTP/HTTP/HTTPS server and selecting a download method. 
Configure a valid URL for TFTP or HTTP, the server name can be the FQDN or IP address format. 

Examples of valid URLs： 

1. firmware.mycompany.com:6688/Grandstream/ 
2. 168.75.215.189 

 
There are two ways to setup a software upgrade server: The Keypad Menu or the Web Configuration 
Interface. 
 
UPGRADE VIA KEYPAD MENU 
To configure the software upgrade server through the keypad menu; select 
“Menu”->”Settings”->”Maintenance”. In the “Upgrade” subpage, users may then select the upgrade mode 
and enter the IP address or FQDN of the Firmware server and the System Config server. After making the 
changes, use the F3 softkey to save the new settings. 
 
UPGRADE VIA WEB BROWSER CONFIGURATION PAGE 
Open a web browser and enter the IP address for the GXV3140. Next, log in with the administrator 
username and password.  Under Maintenance, select “Upgrade and provisioning”, enter the IP address 
or the FQDN (URL) of the upgrade server and choose to upgrade via TFTP or HTTP. Save the changes 
and reboot the unit. 
 
At this moment, the LCD will display the progress of the software download/upgrade. Please do not disrupt 
or power down the unit. 
 
Note: The software upgrade will last up to 5 minutes (through the LAN side) and may take longer when 
upgrading through the Internet (limited by the network bandwidth). Grandstream recommends 
downloading and upgrading the software in a controlled LAN environment.  
 
NO LOCAL TFTP SERVERS 
For users without a local TFTP server, Grandstream offers a NAT-friendly TFTP server. This enables users 
to download the latest software upgrades for their phone via this server. Please refer to the webpage: 
http://www.grandstream.com/firmware.htm. Each product has its own TFTP server address. 
 
 
Alternatively, users can download a free TFTP or HTTP server and conduct a local firmware upgrade. A free 
windows version TFTP server is available for download from 
http://support.solarwinds.net/updates/New-customerFree.cfm or http://tftpd32.jounin.net/.  

http://www.grandstream.com/firmware.htm
http://tftpd32.jounin.net/
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Instructions for downloading and using a free TFTP Server: 
1. Unzip the firmware files and put all of them in the root directory of the TFTP server. 
2. Connect the PC running the TFTP server and the GXV3140 device to the same LAN segment. 
3. Launch the TFTP server and go to the File menu -> Configure -> Security to change the TFTP server's default 
setting from "Receive Only" to "Transmit Only" for the firmware upgrade. 
4. Start the TFTP server and configure the TFTP server in the phone’s web configuration interface. 
5. Configure the Firmware Server Path to the IP address of the PC. 
6. Update the changes and reboot the GXV3140. 
 
End users can also choose to download a free HTTP server from http://httpd.apache.org/ or use 
Microsoft IIS web server. 

 
Note: When the GXV3140 boots up, it will send a TFTP or HTTP request to download the configuration file  
cfgxxxxxxxxxxxx”( “xxxxxxxxxxxx” is the MAC address of the phone). If it is a normal TFTP or HTTP upgrade, 

the following messages “TFTP Error from [IP ADRESS] requesting cfg000b82023dd4 : File does not exist. 
Configuration File Download” can be ignored in the TFTP/HTTP server log. 
 
 
CONFIGURATION FILE DOWNLOAD 
Grandstream SIP Devices can be configured via the Web Interface as well as via a Configuration File through 
TFTP or HTTP/HTTPS. The “Config Server Path” is the TFTP or HTTP/HTTPS server path for the configuration 
file. It needs to be set to a valid URL, either in FQDN or IP address format. The “Config Server Path” can be the 
same or different from the “Firmware Server Path”. 
 
A configuration parameter is associated with each particular field in the web configuration page. A parameter 
consists of a Capital letter P and 2 to 3 (Could be extended to 4 in the future) digit numeric numbers. i.e., P2 is 
associated with the “Admin Password” in the ADVANCED SETTINGS page. For a detailed parameter list, 
please refer to the corresponding firmware release configuration template. 
 
When a Grandstream Devices boots up or reboots, it will issue a request for a configuration file named 
“cfgxxxxxxxxxxxx”, where “xxxxxxxxxxxx” is the LAN side MAC address of the device, i.e., 
“cfg000b820102ab”. The configuration file name should be in lower case letters. 
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RESTORE FACTORY DEFAULT SETTINGS 
 
WARNING: Restoring the Factory Default Settings will delete all configuration information on the phone. 
Please backup or print all the settings before you restore to the factory default settings. Grandstream is not 
responsible for restoring lost parameters and cannot connect your device to your VoIP service provider. 
 
There are two methods to restore the GXV3140 to the factory default settings. 
 
RESTORE TO FACTORY DEFAULT SETTINGS VIA LCD MENU 
 
The steps to restore the phone to factory default settings through the LCD menu are as follows: 
Step 1: Select “MENU” (F1 or the OK button) to enter into the phone menu and select Settings. (Shown in 
the figure below) 

 

Step 2: Press “Select” (F1 or the OK button) to enter into the phone Settings menu and select Maintenance. 
(Shown in the figure below): 
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Step 3: Press “Select” (F1 or the OK button) to access the Maintenance page. In the Upgrade tab, press 
the Down arrow twice to select the Factory Reset option. (Shown in the figure below) 

 

 
 
Step 4: Press the OK button, the phone will display a warning message. (Shown in the figure below) 
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Step 5: Press the OK button again to select “OK”. The phone will reboot and perform a factory reset. 
 
 
RESTORE TO FACTORY DEFAULT SETTINGS VIA THE WEB INTERFACE  
 
Step 1: Login to the system configuration page through a web browser and select “Maintenance”. From the 
menu on the left, select “Upgrade and Provisioning”. This will bring up the upgrade and provisioning page 
as shown in the figure below. 
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Step 2: At the bottom of the page, click on the “Reset” button for Factory reset. A dialog box will pop up (as 
shown in figure below) 

 

 
Click on OK to restore the phone to factory settings. 
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EXPERIENCING THE GXV3140 MULTIMEDIA PHONE  

 
When the user boots the phone for the first time, Account 1 will be registered to the IP Video Talk server 
with a provisioned extension of 810xxxx. If the user has purchased two or more GXV3140 IP Multimedia 
phone, the phones are able to establish video calls between each other and the user can immediately 
experience the plug and play nature of the GXV3140. If the user has only one multimedia phone, the user 
can choose to experience the multimedia features by dialing 0 to establish a video call with the preset 
extension on the server.  

 

 
As shown in the figure above, area A shows the remote video and area B shows the local video.  
When the system boots up for the first time, the phone will establish a video call with the server preset 
extension 0. Users can experience a playback of video on the phone.  
 
Thank you again for purchasing Grandstream IP Multimedia phone, it is sure to bring convenience and 
color to both your business and personal life. 
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